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1 About Greta

1.1 General Program Description

Greta is used for analyzing gravity retaining walls. It performs up to three calculations which
assess the overall stability of the wall with respect to sliding and overturning, the overall stability
with respect to bearing capacity and the shear forces and bending moments in the stem.

The calculation for Overall stability examines the static equilibrium of the wall. For the sliding
and overturning checks the program assumes that full active and passive soil pressures develop
on the virtual boundaries behind and in front of the wall respectively. The wall is assumed to act as
a rigid body together with any soil encompassed by the vertical planes through the extremities of
the base.  For the bearing capacity check the program will, where required, reduce forces on the
passive side of the wall to ensure that the wall is in equilibrium with respect to sliding and
overturning.

In each case the total horizontal and vertical forces are resolved to calculate the force on the base
of the wall. The required reaction of the foundation soil is then calculated to provide equilibrium of
the wall.

The location of the resultant force is also checked and reported. 

The program also calculates the horizontal component of load on the wall and the sliding
resistance of the foundation. The user can specify separate shear strength parameters for the
foundation soil to those used for creation of the active and passive pressures.

The program also calculates the bearing capacity of the foundation, and check it against the
stress developed in the soil below the base.

The Bending moment calculations provide shear forces and bending moments in the stem of
the wall. The calculation also uses the full active and passive pressures on either side of the wall.
These are applied against the stem and and not at the virtual boundaries. In addition to active
pressures behind wall, the user can also specify K0 pressures, and compaction pressures. These
may be used in the structural design of the wall.

Note : 
Separate soil parameters and anchor loads can be applied to each type of analysis.
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1.2 Components of the User Interface

The principal components of Greta's user interface are the Gateway, Table Views, Graphical Output,
Tabular Output, toolbars, menus and input dialogs.  Some of these are illustrated below.

1.2.1 Working with the Gateway

The Gateway gives access to all the data that is available for setting up a Greta model. 

Top level categories can be expanded by clicking on the `+´ symbol beside the name or by double
clicking on the name. Clicking on the `-´ symbol or double clicking on the name when expanded
will close up the item. A branch in the view is fully expanded when the items have no symbol
beside them. 

Double clicking on an item will open the appropriate table view or dialog for data input. 

1.2.2 Preferences

The Preferences dialog is accessible by choosing Tools | Preferences from the program's menu.  It
allows user to modify settings such as numeric format for output, show welcome screen, print
parameters and company information. These choices are stored in the computer's registry and are
therefore associated with the program rather than the data file.  All data files will adopt the same
choices
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Numeric Format controls the output of numerical data in the Tabular Output. The Tabular Output
presents input data and results in a variety of numeric formats, the format being selected to suit
the data.  Engineering, Decimal, and Scientific formats are supported.  The numbers of significant
figures or decimal places, and the smallest value distinguished from zero, may be set by the user.
 

Restore Defaults resets the Numeric Format specifications to program defaults.

A time interval may be set to save data files automatically.  Automatic saving can be disabled if
required by clearing the "Save file.." check box.

Show Welcome Screen enables or disables the display of the Welcome Screen.  The Welcome
Screen will appear on program start-up, and give the option for the user to create a new file, to open
an existing file by browsing, or to open a recently used file.

Company info The company information button in the preferences dialog box allows external
companies to specify the bitmap and Company name that they would like to appear the top of the
printed output.
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To add a bitmap enter the full path of the file.  The bitmap will appear fitted into a space
approximately 4cm by 1cm.  The aspect ratio will be maintained. 
Note! For internal Arup versions of the program the bitmap option is not available.

Page Setup Opens the Page Setup dialog allowing the style of output  for printed text  and graphics
to be selected. 
If 'Calculation Sheet  Layout´ is  selected  the  page  is  formatted  as  a  calculation  sheet  with  details
inserted in the page header. If `Logo´ is  selected the company logo is  inserted in the top left  corner
of  the  page.  If  `Border´  is  selected  this  gives  a  border  but  no  header  information.  If  `Clipped´  is
selected the output is clipped leaving a space for the logo. This has no effect on text output. 

1.3 Program Features

The main features of Greta are summarised below:

Structural Types : A number of different wall shapes may be specified, with tapering and/or
sloping stem, and optional base, toe, heel and key.  

Using the stem wall and gravity wall inputs the following wall types may be specified.

Using the gabion wall input, a gabion wall can be generated with one base layer and up to 4
overlying layers, and this can also be inclined.
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Using the crib wall input, a crib wall can be generated with a base layer and up to 4 stacks of
cribs, and this can also be inclined.

Note : The walls are assumed to be rigid and can only be made of one material type with a single
specified unit weight.

Soil Strata : The program allows a number of different soil strata to be specified behind and in
front of the wall. The ground surfaces may be specified as sloping. 

Soil Coefficients : Different soil coefficients may be specified for the calculation of Bending
moment calculations and Overall Stability.

  
Ground Water Pressures : The groundwater pressure distribution may be defined as a
'hydrostatic' or piezometric.

Load Cases : There are three load cases in the program:

Overall Stability (Sliding/Overturning): This is used for assessing the overall stability of
wall,especially with regards to overturning and sliding failures.

Overall Stability (Bearing): This is used for assessing the stability of the wall with respect to
bearing capacity.  This analysis is optional.

Bending Moment Calculations: This is used for evaluating the bending moments and shear
forces in the wall for structural design calculations.This analysis is optional.

Uniform Surcharges : These act vertically and may be included behind and in front of the wall.
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Discrete Loads : Discrete loaded areas, i.e. strip loads and rectangular loads, can be applied
at a specified distance from the wall or the virtual boundary either over the base or behind the
wall.  This includes both vertical and horizontal loads.

Horizontal Surcharge : Horizontal surcharges, e.g. as per PD6694, can be applied to the
back of the wall.  This can include a uniform distributed load along the back of the stem or
virtual boundary, and a horizontal line load at the top of that boundary.

A line load, acting at the centre of the top of the wall or at a specified distance from the soil/
wall interface, may also be added.  Line loads may be either vertical or horizontal.

Load case 1 is often critical for overall stability (sliding and overturning) calculation.

Load case 2 is often critical for bearing pressure calculations and design for internal
stability.

Ground Anchors can be added down the stem of the wall. Each anchor can have a different
inclination, elevation and anchor force.

   

1.4 Changes for Greta 19.2

A number of changes have been made during updating from Greta 19.1 to Greta 19.2.  Many of
these changes relate to the addition of new features and functionality, including revised wall
geometry, partial factors and additional surcharge types and further information on these can be
found in the relevant sections of this manual.  However, some changes have been made to the
base assumptions and methods used by Greta and the user should be aware of these, especially
if reanalysing files from earlier versions.  These changes are listed here.



Greta

© O as ys  Ltd. 2016 13

Alternate analysis runs

Previously Greta would analyse up to 3 'runs' for each model - 1 overall analysis considering
sliding, overturning and bearing, 1 bending moment run considering Ka, K0 or specified earth
pressures and a further bending moment run considering compaction pressures.  The updated
version of Greta undertakes also undertakes up to 3 runs for each model.  However, the runs
undertaken are not necessarily the same and include 2 runs for overall stability considering sliding
and overturning in the first, and bearing capacity in a second separate run.  A third run is
undertaken to calculate the bending moments considering either earth pressures as previously or
compaction pressures. 

Bending moment analysis

Calculations for bending moments have been modified.  The most significant change is that
bending moments are no longer calculated for the toe and heel of the wall.  With respect to
calculating shear and bending moments in the stem, shear forces along the soil/wall interface are
now considered, and moments are considered about a specific point on the bending axis.  See 
Bending Moment Calculations for further information.

Downgraded data checks

A number of checks are undertaken during the analysis to ensure that results are reasonable and
reliable.  In earlier versions of Greta several of these checks resulted in the calculations being
stopped and no results reported if a check was failed.  The updated version allows some of these
analyses to continue but instead gives a warning in the results, such that the user can decide
whether or not to make use of the results.  The downgraded checks include:

Checking that the resultant force is within the middle third of the base.
Checking that the lateral component of the resultant force is not towards the heel.
Checking that the resultant does not act towards the rear of the wall, i.e. indicating rotation
towards the heel.

Bearing capacity analysis

As stated above the bearing capacity analysis is now undertaken separately from the sliding/
overturning check.  This analysis has now been amended such that the lateral forces on the wall
should be in equilibrium.  This is achieved by reducing first reducing the passive soil pressure,
and, if the wall remains unbalanced when this is reduced to zero then reducing the mobilised base
resistance.  Note that water pressures and anchor forces will not be automatically reduced, and
will need to be reduced manually if equilibrium is not attained even after passive pressures and
sliding resistance have been reduced.



Part II
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2 Methods of Analysis

2.1 General

Greta performs three analyses, the first to determine the overall stability with respect to sliding/
overturning, the second overall stability with respect to bearing capacity of the wall and the third
calculation of bending moments in the wall. The user may decide whether or not to carry out the
latter two of these.

2.1.1 Overall Stability (Sliding/Overturning)

The calculations for overall stability use the soil pressure profiles derived for the virtual
boundaries on back and front of the wall.

Full active and passive earth pressures are calculated to determine the overall equilibrium of the
wall.

For the soil behind the wall the active earth pressure is calculated using the soil coefficients k
a

and k
ac

. The passive pressures in front of the wall are calculated using the corresponding values

of k
p
 and k

pc
. The vertical components of friction and adhesion, for the front and back, are also

included.

Soil and water pressure profiles are calculated for the full depth of the wall, including the shear
key if present. 

These forces are used in the check for sliding and determination of the area and pressure in the
stress block.  Forces are calculated both normal and parallel to the base.  Note that for inclined
walls those normal forces marked with a * will also have component in the parallel direction.
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Normal forces

General Back Front
Weight of wall
(including key)*

Anchor forces

Water pressure under
base

Line load on top of wall

Weight of soil above heel*

Shear on virtual back

Shear on back of base

Weight of soil above toe*

Shear on virtual front

Shear on front of base

   

Note : Vertical shear forces for the depth of the shear key are not included.

Parallel forces

General Back Front
Anchor forces Soil pressure (virtual back)

Water pressure

Soil pressure (virtual front)

Water pressure
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For the sliding and overturning checks, the total stabilising and destabilising forces are calculated.

The total horizontal and vertical forces are resolved to provide an overall resultant force. The
location of the intersection of the force with the base is given, including whether the force is
located within the middle 1/3 or outside the area of the base.

Unstable configurations for the wall would be:

In these cases the results are reported, but with a warning to the user that the results should be
reviewed and may be unstable.

The calculated forces may also need to be adjusted if they indicate that the wall would be sliding
'backwards'.
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In this situation the active and passive pressures will be reversed and therefore the given
calculation becomes invalid.  This situation is allowed for in the sliding overturning check, as it is
acknowledged that the calculated passive forces would not in reality be fully mobilised, and the
factor of safety generated simply indicates the maximum potential resistance.  For the bearing
capacity check the passive resistance would be reduced such that the wall is in equilibrium with
respect to sliding.

2.1.1.1 Plastic stress block

The plastic stress block is defined as the area of plastic deformation beneath the wall.

The total horizontal and vertical forces, calculated for overall stability, are resolved to provide an
overall resultant force. The intersection of the resultant with the base of the wall is used to locate
the centre of the plastic stress block. The total width of the stress block is defined as twice the
distance of the intersection of the resultant force from the toe of the wall at A.

The vertical soil stress within the block is taken as R
v
 / 2x, and

horizontal soil stress as R
h
 / 2x
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2.1.1.2 Sliding check

A check is made on the sliding resistance of the wall using the total horizontal force calculated for
overall stability.

The allowable resistance R
s
 is taken from the input foundation properties where,

R
s
 = R

v
Tand + c

w
 A

b

R
v
 = Resultant vertical force (Overall stability)  

d  = Soil/Base friction angle
c

w
 = Cohesion under base

A
b
 = Area of base, using the stress block (length per unit width).

Having calculated the forces acting on the wall, and the sliding resistance the factor of safety
against sliding is calculated.  This is calculated such that:

Typically the restoring forces will include anchor forces, passive soil forces and water pressure on
the front.  The disturbing forces will typically include active soil pressure and water pressures on
the back of the wall. 

2.1.1.3 Overturning check

Having calculated the forces and resultant moments acting on the wall block, it is possible to
calculate the overturning factor of safety.  This is given by adding up the moments acting on the
wall block, excluding the base reaction, such that:

For which the restoring moments will typically include soil and water pressures acting on the front

of the wall, the mass of the wall and soil in the 'wall block', anchor forces and any loads acting on

the wall.  Disturbing moments will typically arise from soil and water pressures on the back of the

wall.  A breakdown of the forces acting on the block is given in the tabular results output, with

negative moments indicating a destabilising effect and positive moments a stabilising effect.

2.1.2 Overall Stability (Bearing)

The program also checks whether the vertical stress within the stress block is less than the
bearing capacity of the foundation.

Forces on the wall are calculated as described for the sliding/overturning check.  However, it
should be noted that some forces may vary between the two as the critical design case may vary.
 Loads acting on the wall for example would act as a stabilising moment and increase the sliding
resistance, so would be beneficial for a sliding/overturning check and may be excluded in analysis
of a critical case.  For a bearing check though these loads will increase the normal force on the
base of the wall and will therefore have a destabilising effect and are likely to be included for the
critical case analysis.

It should be noted that this check is not carried out taking account of the shear key when
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calculating the maximum bearing capacity.  Effects of the shear key are included in calculating
the active pressure, and passive resistance, but the pressure in the key is not included as a
lateral force on the base, nor is there any adjustment of the base inclination - which may make
the results unreliable where a shear key is present. A warning is given and the user will need to
assess whether or not they can rely on the result, and if required may need to manually calculate
the bearing capacity of the foundation and check whether the induced vertical stress is within
permissible limits.

For information on calculation of bearing capacity, please see Bearing capacity.

2.1.2.1 Lateral Equilibrium

When calculating the forces acting on the retaining wall, these represent the forces that are likely
to be generated at limit state - i.e. for the active and passive pressures that would be generated if
the wall were at the point of failure in sliding or overturning.  It should be noted however, that these
forces are unlikely to be fully mobilised in reality during a bearing failure, and that assuming these
forces may result in a wall that is not in equilibrium.

Where the forces acting on the wall are found not to be in equilibrium Greta will adjust them for
the bearing capacity check.  This is achieved by first reducing the earth pressure acting on the
front of the wall, and if this is not sufficient then reducing the mobilised sliding resistance.

This adjustment is made by reducing the mobilised earth pressure on the front in increments of
0.1%.  With each step reduction the resultant shear resistance on the front face and sliding
resistance on the base are recalculated.  This process continues until either the wall is in
equilibrium with the adjusted forces or the passive pressure is reduced to zero.  If having reduced
the passive resistance to zero the wall is still not in equilibrium then the shear force on the base
is reduced.  Finally, if the wall remains out of balance with both the passive earth pressures and
sliding resistance reduced to zero, the bearing capacity check will continue but a warning will be
given with the results.

2.1.2.2 Bearing Capacity

In order to assess the stability of the wall with respect to bearing, the bearing capacity of the wall
base must be calculated.  This is done using the following parameters and methods.

Calculation of effective stress (q)

Effective stress is the cumulative sum of weight of soil in front of the wall minus water pressure
under base

Effective width of wall (B')

The entire load acting from above is combined into two component forces having V as the vertical
component and H as horizontal component.

The effective width of the foundation is such a way that its geometric centre coincides its load
centre or the width of the plastic stress block i.e. then if the vertical component intersects the
base at a distance a from the toe-heel (whichever is closer) then the width of the base is 2a.

Bearing capacity computation methods

In Greta, the following methods are used for calculation of bearing capacity:

a) Brinch Hansen (1970) : Drained/undrained analysis 
b) Eurocode 7 - Annex D - D3 : Undrained analysis
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c) Eurocode 7 - Annex D - D4 : Drained analysis
d) Meyerhof : Drained analysis

Note: For all these computation methods, the unit weight used in the Ng terms is the saturated

unit weight.  However, the user can choose to override this where this is not appropriate, either
due to absence of groundwater, variations in the groundwater level or varying unit weight with
depth. 

It is recommended that the unit weight used is as follows:

When the groundwater is at or above 0.5B below the base, saturated unit weight and buoyant
weight are used. 

When the groundwater is at or below 1.5B below the base, non-saturated unit weight is used and
no buoyancy is considered. 

When the groundwater level is between 0.5B and 1.5B, interpolate linearly between the above two
values.

2.1.2.2.1  Brinch Hansen 1970

The Brinch Hansen method is taken from the Danish Geotechnical Institute Bulletin No. 28.

This guide gives two formulae for the calculation of the bearing capacity of soils (qmax).  For the

drained case it gives the formula,

And for the undrained case,

For which γ is the effective soil unit weight, B the effective width of the foundation, the N values a

series of bearing capacity factors, and s the shape factors, d the depth factors, i the inclination

factors, b the base inclination factors and g the ground inclination factors.

Note that although cohesion factors are shown in the drained equation (i.e. sc, dc, ic, bc and gc)

the derivation of these values is not given in the guide.  As a result the cohesive component is

ignored, that is, the drained formula is revised such that,

The formula given for the calculation of these factors is given.

Shape factors:



Greta

© O as ys  Ltd. 2016 22

For which B is the width of the wall and L the length.  It is noted that as L is assumed to be

infinite in Greta, the factors are simplified such that sγ = sq = 1, and sc
a = 0.

Depth factors:

For which D is the depth of the wall base, and B the width of the wall base.

Inclination factors:

For which H is the horizontal load per unit length of wall, V the vertical load per unit length of wall,

A the effective foundation area per unit length.

Base inclination factors:

For which ν  is the inclination of the base below the horizontal.  Note that these formulae only

apply where there is a positive angle for ν .  Where there is a negative angle, these should be

taken as bγ = bq = 1 and bc
a = 0.
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Ground inclination factors:

For which β is the inclination of the ground below the horizontal.  Note that these formulae only

apply where there is a positive angle for β.  Where there is a negative angle, these should be

taken as bγ = bq = 1 and bc
a = 0.

2.1.2.2.2  Eurocode 7 Annex D

Eurocode 7 contains 2 methods for calculating the maximum bearing pressure (qmax) under the

effective width of the base such that,

With the factors calculated assuming infinite wall length given by,

For which q is the sum of the overburden and surcharge at foundation level, α the angle of the

base below horizontal (as with the Brinch Hansen method assume bc = 1 if α < 0), H is the

horizontal load per unit length of wall, and B’ the effective width.

In the drained case an alternate method for calculating the maximum bearing pressure is

proposed based on,

With the factors calculated as shown under the respective headers.

Bearing factors:



Greta

© O as ys  Ltd. 2016 24

For the bearing factor Nγ 

Base inclination factors:

Shape factors:

Inclination factors:

As per the undrained case, H represents the horizontal load per unit length of wall, and B’ the

effective width of the base.

Ground inclination factors:

Ground inclination factors are not included within EC7.  However, the user can choose to adopt

ground inclination factors in Greta, using the Brinch Hansen method.

2.1.2.2.3  Meyerhof

The Meyerhof method only considers the drained case.  For this method the bearing capacity can

be calculated assuming,

The factors are calculated as shown under the relevant header.

Bearing factors:
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Shape factors:

Inclination factors:

For φ = 0

For φ > 0

Ground inclination factors:

Ground inclination factors are not included within the Meyerhof method.  However, the user can

choose to adopt ground inclination factors in Greta, using the Brinch Hansen method.

2.1.2.3 Factor of Safety

The factor of safety (FOS) is calculated for bearing failure considering both the average (q) and
peak bearing (q

p
) pressure, and using the maximum bearing pressure calculated (q

max
) such that:

FOS
av erage

 = q
max

 / q

FOS
peak 

= q
max

 / q
peak

The average bearing pressure is calculated assuming that the nett force normal to the base is
spread evenly across the plastic stress block (see Plastic stress block).  

The peak bearing pressure is calculated assuming there is a linear increase in pressure across
the base.  For models where the equivalent force is applied within the middle third of the base,
this will mean the pressure profile is applied across the full width of the base but with varying
pressure, such that the equivalent force is applied at the same point as the resultant.  Where the
equivalent force is outside the middle third of the base this will result in a triangular pressure
distribution across a narrower section of base, such that the equivalent force is applied at the
same point as the resultant.
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2.1.3 Bending Moment Calculations

The bending moment calculations use the soil pressure profiles derived directly on the back and
front of the wall.

For the soil behind the wall the active earth pressure is calculated using the soil coefficients k
a(w)

and k
ac(w)

. These values should allow for compaction stresses where appropriate. The passive

pressures in front of the wall are calculated using the corresponding values of k
p(w)

 and k
pc(w)

.

These values are not necessarily the passive pressure coefficients of the soil, but can be used to
define the stresses the user wishes to be applied to the front of the wall.

Soil and water pressure profiles are calculated for the full depth of the wall.

The forces acting on the wall are:

Vertical forces

General Back Front

Anchor forces
Water pressure (inclined
face)
Line load on top of wall

Shear on back of wall
Soil pressure (inclined back)

Shear on front of wall
Soil pressure (inclined
front)

Horizontal forces

General Back Front
Anchor forces Soil pressure on back of

wall
Water pressure

Soil pressure on front of wall
Water pressure
Shear force (inclined front)
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Shear force (inclined back)

Based on these forces, the total shear force and moment is calculated at a specified number of
points down the bending axis.

2.1.3.1 Bending moments and shear forces

The bending moments and shear forces can be calculated for stem walls, gabion walls, and crib
walls, and are calculated at specified sections down the wall and along the toe and heel of the
base.

The shear forces are calculated from the summation of the vertical and horizontal forces acting on
the stem including:

soil pressures normal to the wall,
shear pressures generated between the wall and soil,
water pressures.

Note that for gabion and crib walls an approximate face is used for the wall, with the rear face
assumed to be a straight line from the bottom right of the base, to the intersect between the wall
and ground as shown in the following.
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The bending moments are calculated by taking a lever arm from the top of the stem, and
considers only those forces acting above the rotation point.  Calculated shear forces are in the
horizontal direction from the specified point on the axis. 

2.1.3.2 Compaction pressures

Based on CIRIA C516, the compaction pressures need not be used for overall stability calculation

where forward movement of the retaining wall is possible (i.e. it is not propped by a structure in

front of it) and acceptable (the deflection would not exceed a serviceability limit state). The

method used for the calculation of compaction pressures was originally proposed by Ingold

(1979), but has been stated more recently by Symons and Clayton (1992). The pressures

calculated are most relevant for the internal design of retaining walls with reinforced concrete

stems. The stem deflection is often too small for these locked in pressures to be relieved by its

forward deflection.
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Using this method pressures greater than those calculated from Ko v
’ are present to a depth they

called hc defined as 

Where K0 is coefficient of earth pressure at rest, P is the effective line load per meter of the roller,

and g is the density of the material undergoing compaction. 

The maximum pressure s’
hrm can be calculated from 

and this occurs below a depth z
cr

 where
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2.1.4 Earth Pressures

The active and passive earth pressures are calculated at the top and base level of each stratum
and at intermediate levels where there is a change in linear profile of pressure with depth e.g.
location of phreatic surface. The active and passive coefficients should take account of the
inclination of the wall to the vertical, the sloping ground in front and behind the retaining wall (if
any), the wall roughness, the selected design approach, the limit state being considered, etc.

Intermediate levels are also placed at the top and underside of the base and bottom of the shear
key. The effective active and passive pressures normal to the wall are denoted by p'

a
 and p'

p

respectively. These are calculated from the following equations:-

p'
a
 = k

a
s'

v
 - k

ac
 c'

p'
p
 = k

p
 s'

v
 + k

PC
 c'

Where,
c = effective cohesion or undrained strength, as appropriate
s'

v
= vertical effective overburden pressure

Note : Modification of the vertical effective stress due to wall friction should be made by taking
appropriate values of k

a
 and k

p

k
a
 and k

p
= horizontal coefficients of active and passive pressure

k
ac

 and k
pc

= cohesive coefficients of active and passive pressure

   
Note : For conditions of total stress k

a
 = k

p
 = 1.

For a given depth z

Where,   
g
s

= unit weight of soil

u = pore water pressure
s

zudl
= vertical sum of pressures of all uniformly distributed loads (udls) above depth z.

A minimum value of zero is assumed for the value of (k
a

s'
v
 - k

ac
 c').

Alternatively, the user may also choose to consider "at rest" pressures behind wall. In this case,
the pressure behind wall is calculated as:

p'
0
 = k

0
s'

v
,

Where,

k
o
 is the coefficient of earth pressure at rest.

Another option is for the user is to use average of at rest and active pressures behind wall. In this
case, the average of the above two values is used.

The last option is to apply "factored" ka pressures. In this case, the active pressures are initially
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calculated as explained above, then they are factored by a user-defined factor.

2.1.4.1 Calculated earth pressures

Where the user chooses to use calculated earth pressures, the user can choose whether to specify
earth pressure coefficients using the EC7 or C516 methods. 

2.1.4.1.1  EC7 Method

If the EC7 method is specified the earth pressures will be calculated using the analytical procedure
presented in section C.2 of EN 1997-1:2004 Annex C. 

The following symbols are used in the equations:

? ' angle of shearing resistance of soil (degrees)

δ wall/soil friction angle (degrees)

β angle of ground surface to horizontal (degrees, positive if the ground level increases with distance
from the wall)

θ angle of face to vertical (positive if the soil overhangs the wall)

Note that β
0
 is taken as β.  According to the standard this should be acceptable if c = 0 and the

surface load is vertical, and for active pressures generally.

Drained Analysis

The coefficient of earth pressure for loads normal to the surface boundary, Kn is given by:

where,

And

ν  = mt + β - mw - θ

mt , mw and ν  have units of degrees. However, ν  must be converted into radians before substitution
into the above equation for evaluating Kn.

The value used for the earth pressure coefficient in Greta is the earth pressure coefficient for soil self

weight and this in turn is given by:
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For calculation of active earth pressure coefficients, the angle of shearing resistance of the soil and
the wall/soil friction angle must be entered as negative values.

For calculation of passive earth pressure coefficients positive angles should be used.

The cohesion component Kc can be calculated such that:

K
c
 = (Kγ-1)cot?

Undrained Analysis

In the undrained case the coeffcients are given by:

K
n 

= 1

and 

K
c
= 2v + sin2m

t
 + sin2m

w
 

The values of m
t
 and m

w
 can be taken from,

and

For which p is the pressure on the ground surface, c is the soil cohesion and a the adhesion along
the boundary being considered.  Note that within Greta p is always taken as 0 for calculation of Kc,
this will typically be conservative for loads on the active side but unconservative for loads on the
passive side.

For calculation of v, use the same equation given for the drained case.

2.1.4.1.2  C516 Method

Where the C516 method is specified by the user, earth pressure coefficients are calculated using
the method presented in CIRIA report C516 'Modular Gravity Retaining Walls - Design Guidance'
2000 in Section 6.3.

Using this method the earth pressure coefficients can be calculated using the following
parameters:

?  angle of shearing resistance of soil (degrees)
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δ wall/soil friction angle (degrees)

β angle of ground surface to horizontal (degrees, positive if the ground level increases with
distance from the wall)

c cohesive strength of soil

a adhesion along soil/wall boundary or virtual boundary

The earth pressure coefficients then given by:

It should be noted that this method is for horizontal earth pressures and is therefore not likely to

be suitable for inclined walls, where the normal pressure is not horizontal.  Other limitations are

as stated within the C516 report.

2.1.4.2 Friction and adhesion

Stresses due to friction are calculated at the virtual back and front of the wall for assessment of
overall stability and at the wall surface for calculation of the forces in the stem and base. Based
on Section 9.5.1(6) Eurocode EN1997-1:2004, the amount of shear stress, which can be
mobilized at the wall-ground interface, should be determined by the wall-ground interface
parameter . 

A concrete wall or steel sheet pile wall supporting sand or gravel may be assumed to have
a design wall ground interface parameter = k where k should not exceed 2/3 for precast
concrete or steel sheet piling

For concrete cast against soil, a value of k=1.0 may be assumed.

For a steel sheet pile in clay under undrained conditions immediately after driving, no
adhesive or frictional resistance should be assumed. Increases in these values may take
place over a period of time. 

For walls where the virtual back is unrestrained fill to fill, the interface angle of wall friction 
 should be considered to be zero(CIRIA C516).

Overall Stability

For the virtual back and front and ends of the wall base the tangential stresses are taken as:

boundary friction (active)   =  p'
a
 tan f

0
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boundary friction (active)   =  p'
p
 tan f

0

boundary adhesion   =  c
0
h

Where,
f
0
 = specified boundary friction for overall stability

c
0
 = specified boundary cohesion for overall stability

Bending moment calculations

Where the wall stem remains vertical the friction calculation at the wall interface (stem and base)
is the same as for overall stability, but uses the friction parameters given for calculation of the
Bending moment calculations.

Where the wall stem is inclined the calculations for the friction forces are separated into their
horizontal and vertical components, where;

Friction

horizontal friction (active) = p'
a
 tany

b
 tanf

w

vertical friction (active) = p'
a
 tanf

w

horizontal friction (passive) = p'
p
 tan y

f
 tanf

w

vertical friction (active) = p'
p
 tanf

w

Where,
y = angle of the wall stem to the vertical (front and back)
f = specified friction for Bending moment calculations

Adhesion

horizontal cohesion (active) = p'
a
 tany

f
 c

w

vertical cohesion (active) = p'
a
 c

w

Use p'
p
 for passive equations.

c
w
 = specified wall adhesion for Bending moment calculations

For information on friction beneath the base of the wall see, Sliding check.

2.1.5 Base Optimisation

Greta provides a tool to optimise the base width by iterating the base width to achieve the
minimum possible width giving full mobilization of soil strength , the wall is checked for sliding,
overturning, bearing, and uplift using the factors of safety provided by the user.

The tool can be used to optimise the base width, and also find the minimum toe or heel length.

To see how to use this tool please refer to Base optimisation tool

2.1.6 Surface Loading

Within Greta it is possible to model the effect of a range of surface loads on the stability of the
wall.  Greta models both the direct effect of vertical and horizontal loads applied directly on the
wall, as well as the increase in earth pressures attributable to both vertical and horizontal loads
applied in front of or behind the wall.



Greta

© O as ys  Ltd. 2016 35

2.1.6.1 Uniform distributed loads

There are two types of uniform distributed load (UDL) allowed in Greta; UDLs including the wall,

and UDLs excluding the wall.  Where the wall is included the UDL extends all the way to the stem

(likely to be the critical case for bearing capacity and shear/bending checks), where it is excluded

the UDL extends only to the virtual back/front (likely to be the critical case for overturning and

sliding checks).    

With respect to the resultant horizontal pressure on the back face there are fundamentally two

cases to consider.  The first is the case where the UDL extends all the way up to the back face,

i.e. UDL including the wall and UDL excluding the wall for the sliding/overturning case and bearing

case.  The second case is where the UDL is offset from the wall, i.e. the UDL excluding wall for

the bending/shear analysis case.

For the first case the pressure profile constant down the back face.  The increment in pressure

(∆q) is given using the active/passive earth pressure as appropriate (K) multiplied by the surface

pressure (qudl), such that ∆q = K x qudl.

For the second case, the pressure profile is as shown below.

The maximum pressure on the stem in this case is the same as that calculated in the first case. 

However, it is also necessary to identify the point along the face at which the pressure starts to

increase, and the point at which the peak pressure is achieved.  These can be derived from the

wall geometry, with the first point being derived by taking a line at angle of φ below the horizontal

from the edge of the loaded area (i.e. the top of the virtual back) to the back of the stem.  The

second point is taken from a line at an angle α from the edge of the loaded area to the back of the

stem.
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The value of α is given by: 

It may be necessary to extrapolate beyond the ends of the line of the back face, to intersect with

the line at angle α.  Where this occurs the pressure at the base of the back face can be taken

assuming a linear increase in pressure between the first and second points.

2.1.6.2 Line loads

Greta is able to model the effect of line loads either above or behind the wall.

A line load is assumed to be a load along an infinite length line parallel to the wall.

To specify the line load the user must first select line load for the load shape.  The location must

then be chosen, this can be defined as ‘over’ and ‘behind’.  

Loads defined as over indicate line loads applied to the surface between the front and back virtual

boundaries.  The offset in this case indicates the distance from the soil/wall interface and the line

load.  A negative offset indicates a load in front of the wall, and a positive offset a load behind. 

Where an offset of 0 is applied the load will be applied centrally at the top of the wall.

If the location is set to behind, then the load is located behind the rear virtually boundary with the

offset (always positive) indicating the distance from the virtual boundary to the line load.

Both vertical and horizontal loads can be applied and these are specified as the magnitude of

force per unit length of the line load.

The methods used to calculate the effect of line loads depends on the calculation case being

considered and the location of the line load.

Where line loads are over the wall and calculations for sliding, overturning and bearing are
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undertaken the loads are added directly to the nett vertical and horizontal forces acting on the

wall.  For the moment calculation the moment is calculated directly from the force magnitude and

the offset from the toe.

Where line loads are located behind the wall (for overturning, sliding and bearing checks) or

behind the stem (for bending/shear checks) the equivalent horizontal pressures on the back face

is calculated.  For the overturning, sliding and bearing checks the back face is taken as the rear

virtual boundary.  For the bending/shear check the back face is taken as the back of the stem –

assuming a straight line between the soil wall intercept at the back, and the point at which the

stem joins the base.  

Vertical loads

For vertical line loads the equivalent horizontal pressure is calculated using the PD 6694 method

described in section 7.6.3 of that document.

This method uses the following variables:

QL as the line load per unit length along wall

a as the offset of the line load from the back face

Pn as the total horizontal load on the back face

φ’ as the soil internal angle of friction.  Where there are multiple strata the mean value across

the strata between the level of the line load and level of the bottom of the face the pressure acts

on is used.  Note that this requires iterations to determine.

α as the angle between the horizontal and a line between the load and the bottom of the

resultant pressure on the rear face

H is the height of the rear face

Y the height of face that the pressure acts on

σmax the maximum pressure on the back face

Of these QL, a and  φ’ are specified by the user, and H can be determined directly from the

geometry.

Knowing these α can be calculated such that it is given by the minimum of:

 

And 

Having determined α the height Y can be determined from the wall geometry.
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The total thrust on the wall can then be calculated using:

And the maximum stress is given by:

Having determined the pressure profile attributable to the line load this can be added to the total

soil pressure on the back face. The shear on the back face and moment about the toe of the wall

can be calculated from that.  This gives a soil pressure profile as shown below.

Horizontal loads

An alternate method has been adopted to determine the pressure profile attributable to the

horizontal component of a line load.  In this case the pressure profile and parameters are as

shown below.
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This method uses the variables QL, a, φ’, α, H, Y and σmax, defined as for vertical loads, with the

exception that QL refers to the horizontal load. 

Of these QL, a and  φ’ are specified by the user, and H can be determined directly from the

geometry.

Knowing these α can be using the same method as that proposed for a vertical line load.  Having

determined α the height Y can be determined from the wall geometry, and the maximum stress is

given by:

Having determined the pressure profile attributable to the line load this can be added to the total

soil pressure on the back face. The shear on the back face and moment about the toe of the wall

can be calculated from that.

2.1.6.3 Line (wall) loads

Line (wall) represent loads applied directly to the wall and may be useful where loads are applied
directly to the wall.  As these are intended to represent loads applied directly to the structure
these do not have any effect on the soil pressures, and can only be applied as 'over' the wall.  The
total vertical and/or horizontal load per unit length will then be incorporated into the total moment,
vertical and horizontal forces acting on the wall, based on the forces applied and the offset from
the toe.  Note that for data entry positive vertical forces are considered to be acting in a
downwards direction, and positive lateral forces are considered to be acting from right to left.

Line (wall) loads are defined by setting the offset from the centre top of the stem with a positive
offset moving the point for load application to the right.  The level is set by the user allowing for the
load to be applied at a vertical offset from the wall, which may be appropriate in cases where the
load is applied to a barrier or platform fixed to the wall rather than directly to the wall stem.
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For calculation of the stem shear/bending moments the force will be included in calculations for
points on the stem below the level at which the load is applied. 

2.1.6.4 Strip loads

Strip loads can also be applied in the updated version of Greta.  Strip loads are applied in a

similar manner to line loads (i.e. they can be applied over and behind the wall, at an offset as

described for line loads).  However, to define a strip load you must also enter the width of the

strip, and both the vertical and horizontal pressure applied within the area defined by the strip.

Vertical pressure

The method adopted to model the effect of strip surcharges on the wall, is the same as that used

in Frew. 

 

From theoretical considerations the approximation illustrated above was developed to represent
the increase in the active pressure limit, thus transferring the vertical pressure to a horizontal
pressure on the wall.

This shows the shape of the pressure limit diagram and the criteria for calculation.

It should be noted that if the width of the load (B) is small, the diagram will become triangular.
This pressure distribution is then used to modify the active pressure limit. Comparison of this
distribution with the parametric studies undertaken for Frew suggests that it is generally
conservative.

If Ka varies with depth it is considered conservative to choose a mean value of Ka between any
depth z and the level of the surcharge and then impose the criteria that the active force due to the
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surcharge, down to depth z be equal to the force derived from the above diagram. 

Additionally where the base of the wall is at an elevation greater than the base of the affected area

as shown above, the total load on the wall should be taken as P = q B (α-φ)0.5 , for which α is the
angle from the outside edge of the load to the base of the wall below the horizontal.  It should be
noted that in this case there is potential for the total load to exceed that generated using the
above method, in this case the pressure should be taken a qKa from the point at which the peak
pressure is reached down to the base of the wall.

Horizontal pressure

For horizontal loads the method adopted is similar to that used for line loads.  The differences that

need taken into account for strip loads are:

The base of the area affected by the load is taken using the angle α and the outside edge of the

strip.

The total load is the product of the horizontal pressure (qh) and the width (b), i.e. the peak

stress is taken as .

So for a horizontal strip load the generated pressure would be as shown below.

As with the line loads, Greta will automatically increase the value of the offset used in

calculations where the load is defined as behind and calculations of shear/bending in the stem

are being undertaken.

Where the strip load is ‘over’ the wall, the total load per unit length of wall (Q) can be calculated

taking the pressure (q) and multiplying by the width (b), i.e. Q = qb.

The load is assumed to act at the centre of the strip, and the lever arm about the toe can be

calculated from the geometry.
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2.1.6.5 Rectangular loads

A rectangular load is defined by a shape and location.  Similar to the line load this can be defined

as behind and over the wall, with the offset (a) measured from the virtual back or wall stem as

appropriate.  Having done this the size of the loaded area should be added, this includes defining

the width (b) (size perpendicular to the wall) and the perpendicular length (c) (size parallel to the

wall).  Finally the user can specify the segment length (d), this is the minimum length of wall that

may credibly fail, and therefore the shortest length over which loads can be distributed.

For rectangular loads the total vertical and total horizontal load across the loaded area is entered

rather than the pressure.

There is no separate method that deals with rectangular loads.  Instead the loads are converted

into an equivalent strip load, and from that the pressure on the back of stem/virtual back is

calculated.

To calculate the equivalent strip load first the pressure (q) under the rectangular load is

calculated, this is done by taking the total vertical/horizontal load (Q) and dividing by the area,

i.e. .

Next a reduction factor (f) can be calculated, assuming that the load ‘spreads’ at an angle of 45°.
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The length of the wall affected is taken as the maximum of the geometric length calculated from

the load geometry, as shown above, or the segment length.  Based on this:

From this the equivalent strip load pressure (qes) is given by:

The width and offset for the equivalent strip load are taken as the width and offset for the

rectangular load. The effects of the strip load can then be calculated in accordance with the

method described in Strip loads.

Where the load is applied ‘over’ the wall, the horizontal and vertical load on the wall block as well

as the moment about the toe will need to be calculated for checks of the sliding and overturning

resistance and bearing capacity.  The vertical and horizontal loads can be taken from the user

input and divided by the maximum of the perpendicular length and the wall segment length to get

the load per length of wall, with no further calculations required.

For this check it is assumed that the loading is distributed evenly within the rectangle, and the
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load can therefore be considered to act at the centre point.  From this the lever arm both vertically

and horizontally about the toe of the wall can be calculated from the geometry.

2.1.6.6 Horizontal surcharge

A horizontal surcharge method is also included in Greta.  This applies a horizontal surcharge

load, e.g. as per traffic loads on abutment walls as described in PD6694-1.

This load case is relatively simple as it applies a UDL and line load directly to the back of the

wall.  To apply this the user need only select the horizontal surcharge method, then enter the

required load and pressure.  The line load, specified in force/unit length, is applied as a horizontal

line load at the top of the back face.  The pressure is applied as a horizontal UDL across the

whole of the back face.

2.1.7 Partial Factors

Partial factors can be applied in Greta.  Where these are applied the factors are applied such that:

For load factors, the design load is given by the load entered by the user multiplied by the
partial factor.  Note that this is only applied to surface loads specified by the user and not loads
derived from other sources, e.g. groundwater or soil lateral earth pressures.
For unit weight, the design unit weight of soils is given by multiplying the specified soil weight
by the factor.
For cohesion, the design cohesion is given by dividing the specified cohesion by the factor. 
For friction, the design friction angle φ

d
 is derived by dividing the tangent of the specified friction

angle φ by the factor γ
phi

, i.e. φ
d
 = tan-1(tan(φ)/γ

phi
).

Note that no partial factors are applied to water unit weight, or to forces and moments derived from
water pressures and weight.



Part III
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3 Input

3.1 Assembling Data

It is best to make a sketch of the problem before the computer is approached . This should
comprise a cross section of the proposed wall with the:

ground surface level and inclination  

location of each soil strata  

parameters of each material (Overall stability and Bending moment calculations)  

foundation material parameters  

phreatic surface  

location of any piezometers  

magnitude of any loads  

location of any anchors.

3.2 Opening the Program

The following provides details of all the data required to run the Greta program.

On selection of the Greta program the main screen will open.
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This is the main screen within which all data, graphics and results are entered and viewed. All
further information appears in a series of smaller or "child" windows, which are placed inside the
main screen.

To start a new project file select :
The "Create a new data file" option on the opening screen

File | New or  the icon .

 

This will open a new Titles window and allow you to proceed.

It is possible to open more than one data file at any one time. The file name is therefore displayed
in the title bar at the top of each child window.

3.2.1 Intranet link and emails

To view the latest information regarding the Greta program or contact the support team click on

the internet   or support team buttons on the Start screen or select the options from
the toolbar. 

List of information required and actions before contacting support team: 
Version of Greta (see top bar of program or Help | About Greta)
Spec of machine being used
Type of operating system
Please pre-check all input data
Access help file for information
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Check web site for current information
Should you report a program malfunction then please attempt to repeat and record process prior
to informing the team.

The web site aims to remain up to date with all data regarding the program and available versions.
Should any malfunctions persist then the work around or fix will be posted on the web site. 

In addition, if the user wants to email the input file that he/she is currently working on, to the
support team, he/she can do so by clicking File|Email... button.

3.3 Data Input Screens

Data is input via the Data menu or the Gateway.

The information can be entered in any order, but Material Properties should be entered before
specifying Material Layers.

Once the data has been entered the program places a tick against that item in the menu list.

The following describes each of the menu items in detail.
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3.3.1 Titles

The first window to appear, for entry of data into Greta, is the Titles window.

This window allows entry of identification data for each program file. The following fields are
available:

Job Number 
allows entry of an identifying job number.

Initials 
for entry of the users initials.

Date 
this field is set by the program at the date the file is saved.

Job Title 
allows a single line for entry of the job title.

Subtitle 
allows a single line of additional job or calculation information.

Calculation Heading 
allows a single line for the main calculation heading.

The titles are reproduced in the title block at the head of all printed information for the
calculations. The fields should therefore be used to provide as many details as possible to identify
the individual calculation runs. 

An additional field for notes has also been included to allow the entry of a detailed description of
the calculation. This can be reproduced at the start of the data output by selection of notes using
File | Print Selection. 
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3.3.1.1 Titles window - Bitmaps

The box to the left of the Titles window can be used to display a picture beside the file titles.
To add a picture place an image on to the clipboard. This must be in a RGB (Red / Green / Blue)

Bitmap format. Select the  button to place the image in the box.

The image is purely for use as a prompt on the screen and can not be copied into the output data.

Note : Care should be taken not to copy large bitmaps, which can dramatically increase the size
of the file.

To remove a bitmap select the  button.

3.3.2 Units

The Units dialog is accessible via the Gateway, or by choosing Data | Units from the program's
menu.  It allows the user to specify the units for entering the data and reporting the results of the
calculations.  These choices are stored in, and therefore associated with, the data file.

Default options are the Système Internationale (SI) units - kN and m.  The drop down menus provide
alternative units with their respective conversion factors to metric.

Standard sets of units may be set by selecting any of the buttons: SI, kN-m, kip-ft kip-in.

Once the correct units have been selected then click 'OK' to continue.

SI units have been used as the default standard throughout this document.
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3.3.3 Analysis Options

The analysis options allows the user to specify the number of sections down the stem of the wall
to be taken for calculation of the shear forces and bending moments.

If the box for "Include derivation of Bending moment calculations" is checked then the calculation
for shear forces and bending moments will proceed. Otherwise they will not be reported.

Further, the user may specify the method to be used for calculating soil pressures behind the
wall, as explained in Earth Pressures.

The user the pressures behind the wall to be calculated taking account of compaction, this will
also require additional data such as effective line load per metre of roller (for calculated
compaction pressures), or critical depth for compaction pressures and the depth where
compaction pressures remain significant (for user specified compaction pressures). Compaction
pressures are calculated as described in Section 6.4 of CIRIA C516 (2000) design guidance on
modular retaining walls.
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3.3.4 Material Properties

The properties for the different materials, on either side of the wall, are entered in tabular form. For
the data input select 'Material Properties' from the Data menu or the Gateway.

Brief descriptions for each of the material types can be entered here.

General parameters for each material are entered on the first page of the table, this includes
specifying whether soils are drained or undrained (used to determine which factor to use for
cohesion) and whether to use user specified or calculated earth pressure coefficients.

Individual parameters for each of the methods of solution must then be entered. The relevant
tables are accessed by moving the mouse over the tabs at the bottom of the table and clicking
the left mouse button.

Material Properties for Overall Stability

Material Properties for Bending moment calculations

Overall stability Bending moment
calculations

Description

Virtual boundary
friction

Soil / Wall friction Angle of friction in degrees
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Virtual boundary
adhesion

Soil / Wall
adhesion

Adhesion c
w

k
a

k Active earth pressure

k
ac

k
c

Active earth pressure due to cohesion

k
p

k
pw

Passive earth pressure

k
pc

k
cw

Passive earth pressure due to cohesion

On occasions the user may wish to model an excavation in front of the wall. This can be achieved
by including a soil type 'Air' in front of the wall. Parameters chosen should use a minimal bulk unit

weight, (e.g. 0.01 KN/m3), low shear strength (e.g.f = 1.00), and coefficients K(e.g. 0.1). This will
help to provide minimal passive resistance in front of the wall.

3.3.5 Material Layers

The level of the base of each material layer must be entered. The levels can be different on either
side of the wall only to the level of the underside of the base slab. Material Layers can be
entered by selecting 'Material Layers' from the Data menu or the Gateway.

Beneath the base slab the same soil type must be selected for both sides of the wall. Only one
soil type is analysed for sliding resistance and bearing capacity.

For each material layer, the level of the base of the layer and the material type must be entered.
The material type is selected from a drop-down list of all the descriptions entered in the Material
Properties module.

3.3.6 Foundation Properties

The foundation properties used to assess the wall stability against sliding, and for bearing
capacity calculations should be entered here.

There are three data groups:



Greta

© O as ys  Ltd. 2016 54

Soil structure interaction - The friction and cohesion data used for calculating vertical shear at the
front and back of the base are entered here. This data is also used to calculate the resistance
against sliding.  The user can also indicate whether the foundation soils are to be analysed as
drained or undrained, this affects both the sliding resistance and bearing capacity calculation
(adjusting the partial factors used and the available methods to calculate the bearing capacity).

Bearing capacity data: The user can choose to enter the cohesion and friction data from pre-
defined materials from the Materials table, or define them separately. The user has to specify
drainage type and the method used in bearing capacity calculation. The following methods are
available:

1. Brinch Hansen (1970) - Drained analysis
2. EC7 - Annex D - D3 - Undrained analysis
3. EC7 - Annex D - D4 - Drained analysis
4. Meyerhof - Drained analysis

These are covered in detail in Bearing Capacity

For a user defined foundation material the unit weight used in the Ng terms is calculated as

follows:

- When the groundwater is at or above 0.5B below the base, saturated unit weight and buoyant
weight are used. 

- When the groundwater is at or below 1.5B below the base, non-saturated unit weight is used and
no buoyancy is considered. 

- When the groundwater level is between 0.5B and 1.5B, interpolate linearly between the above
two values. 

If using material parameters from one of the materials in the materials table, then by default the
unsaturated unit weight is used.  However, where required the user can check the override
effective unit weight box, and enter their own value for the parameter.

The Meyerhof and Eurocode 7 methods for the calculation of bearing capacity do not include
factors to take account of ground inclination.  If required the Brinch Hansen factors can be used
with these methods by checking the relevant box.

FoS Data - The user then has to specify the factors of safety to be used in calculation of bearing
sliding and overturning scenarios.
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3.3.7 Groundwater

Groundwater data for the front and back of the wall is entered. Different levels and pressures can
be used for assessment of the overall stability and Bending moment calculations. The value of the
unit weight of water is, however, a global value for all piezometers. Groundwater can be entered in
tabular form by selecting 'Groundwater' from the Data menu or the Gateway. 
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If only one data point is entered for either side of the wall, the program will assume a hydrostatic
groundwater distribution on that side of the wall. The pressure specified at the point need not
necessarily be zero. For the first point on each side of the wall, the unit weight of water must also
be entered.

For hydrostatic distributions the water pressure (u) is calculated from

u = z
w
g
w

Where,   
z

w 
is

 
depth below water table level, and

g
w
 is  specified unit weight of water. 

Thus a partial hydrostatic condition can be modelled by specifying a value of g
w
 less than 10kN/

m3.

Note : All defined water pressures are assumed to extend laterally from either side of the wall.
For piezometric profiles the level and pressure at each known point must be entered. If more than
one data point is entered, the program will assume that the points represent piezometers, and the
groundwater pressure will be interpolated vertically between the specified points. Below the lowest
point, groundwater pressure will be assumed to extend hydrostatically.

The groundwater pressure beneath the base slab is assumed to have a linear profile between the
elevations at the front and back. Groundwater flow beneath the wall is not modelled.

Where analysis is being undertaken using partial factors, it should be noted that neither the
groundwater pressure nor forces and moments applied to the wall from this are factored. 

3.3.8 Discrete Loads

Discrete loads can be applied to the model as described in Surface Loading.

These are entered using the discrete loads table.  This table contains two tabs, one to enter data
relating to the load shape and location, and the second to specify the required loads or pressures.
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Within the Shape tab the following information is added:

Name - a brief description of the load being entered.
Load shape - select from the available load shapes, i.e. Uniform distributed loads, Line loads,
Strip loads, Rectangular loads or Horizontal surcharge.
Location - select whether to apply the load in front, over or behind the wall.
Offset - this measures the distance between the load and the boundary considered, i.e. distance
from the wall soil/wall boundary for loads 'over' and distance from the front or back virtual boundary
for loads specified as in front or behind.  Note that for line loads located over the wall an offset of 0
can be used to apply a load to the top centre of the wall itself, and a negative offset can be used
to apply the load in front of the wall.
Width - for strip loads this specifies the width of the strip, for rectangular loads it specifies the
size of the rectangle perpendicular to the wall.
Perpendicular length - this is only required for rectangular loads, and specifies the length of the
rectangular load perpendicular to the wall.
Segment length - this indicates a critical length of wall representing the minimum credible failure
length, for modular walls this may be the length of each module otherwise if there is any
uncertainty a value of 0m can be applied.

Within the Loading tab the following information is added:

Vertical load - for line loads this specifies the vertical load per unit length along the line, for
rectangular loads this specifies the total vertical load.
Horizontal load - for line loads this specifies the horizontal load per unit length along the line, for
rectangular loads this specifies the total horizontal load, and for horizontal surcharge this
specifies the load per unit length to be applied at the top of the virtual boundary.
Vertical pressure - for strip loads and UDLs this specifies the vertical pressure within the loaded
area.
Horizontal pressure - for strip loads and UDLs this specifies the horizontal component of pressure
within the loaded area (note that a positive load is assumed to be towards the wall), for the
horizontal surcharge this specifies the horizontal pressure applied to the back of the wall/virtual
boundary.
Load type - this defines whether the load should be treated as permanent or variable, i.e. for
selection of appropriate partial factors.
Partial factors - for each analysis the user can select how the load should be treated by the partial
factors with the available options being unfavourable, favourable, unfactored or ignore.  Where
unfavourable or favourable is selected for a given analysis type, the load is applied for that
analysis using the relevant factor.  Where unfactored is selected the load is applied for the given
analysis type but is not factored.  Where ignore is selected the load is not applied for the chosen
analysis type.
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3.3.9 Anchor Loading

Anchors can be placed in the stem below the ground level at the back of the wall and above the
top of the base slab. Anchors can be entered in tabular form by selecting 'Anchor Loading' from
the Data menu or the Gateway.

Each anchor can have a separate force applied for analysis of overall stability and Bending
moment calculations. A single angle to the horizontal is required, note that the sign convention is
such that a positive angle is used for anchors rotated clockwise about the head and a negative
angle for anti-clockwise rotations.

Anchor forces can also be used to represent forces in shores and struts.

Note : Users must satisfy themselves independently that the anchor systems are capable of
sustaining the specified forces.

3.3.10 Base Optimisation Tool

The base width optimisation for optimum utilization of external properties can be carried out using

the base optimisation tool, this can be accessed by clicking the  on Greta toolbar or from
Tools | Optimise base from Data menu
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The tool dialog box is divided into three sections
Initial Geometry of wall that shall be edited only if the optimised results are accepted by the
user,
The optimisation and editing section where the user can specify different heel and toe width and
optimise the other for the one he has specified
And the "Comparison of results" sheet

3.3.11 Wall Geometry

The geometry of the wall and wall weight must be defined here.  The wall type can be chosen
using the buttons at the top of the dialog box, this will change the figure and data entry boxes for
the wall.  The parameters defining the wall and soil geometry can then be entered.  
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3.3.12 Partial Factors

Partial factors dependent on the method and on material parameters can be specified. A default
set of partial factors is built in to the program, and the user can create and save additional partial
factor sets - these additional sets will be stored in an XML file and will be accessible for use on
any file - if a data file containing user-defined values is sent to another user, the values will be
extracted from the data and saved to the second user's XML file. 

The default partial factor sets include factors recommended by BS EN 1997-1:2011 (Eurocode 7)
SLS and Design Approach 1, combinations 1 and 2.

The default partial factor set is for an SLS analysis, i.e. the program assumes all factors equal to
1.0. 

Partial factors can be applied to:

favourable or unfavourable, and permanent or variable loads

soil unit weight 

drained or undrained cohesion

soil friction angle
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To use an existing partial factor set, select the required set from the drop down list and click on
'Apply'.

To modify an existing partial factor set, first select the set that you wish to modify from the drop
down list.  Next adjust the factors that you wish to change, and then click on 'Modify'.  Finally if
you wish to use the modified partial factor set for a given analysis then click on 'Apply'.  Note that
only user created partial factor sets can be modified in this way.

Finally, to create a new partial factor set type the name of the new set into the drop down box. 
Next adjust the partial factor in each of the text boxes to the required value, then click 'Add' to add
the specified set to the program.  If you wish to use the newly created set for the current analysis
then select 'Apply'. 

Note that partial factors are not applied to groundwater pressures or to the forces and moments
generated by groundwater.  



Part IV
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4 Output

4.1 Analysis and Data Checking

Results can be obtained by selection of the Analysis menu.

Prior to analysis the program carries out a data check.

The data checks carried out are as follows:
The material layers beneath the base slab are the same between the front and back.  
The anchors are all placed at or below ground level and above the top of the base.  

If no errors are found then the calculation can proceed. Select OK.

Note: The option to Delete results becomes available once the calculations have been completed.

4.2 Tabular Output

Tabular Output is available from the View menu, the Gateway or the Greta toolbar. The results are
provided in both a full and condensed tabular form. The lists of tabulated output can be highlighted
and then copied to the clipboard and pasted into most Windows type applications e.g. Word or
Excel.  The output can also be directly exported to various text or HTML formats by selecting
Export from the File menu.
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4.3 Graphical Output

Graphical output is accessed via the view menu using View | Graphical Output, the Gateway or
the Greta Toolbar.
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The graphical representation of the soil layers, the retaining wall, and surcharges is shown here.

This window has a toolbar which has buttons corresponding to different physical quantities like
active and passive pressures, pore-water pressure, soil layers and, bending moment and shear
force diagrams.

When the user makes the appropriate selection, the corresponding plot is shown. 

The plot can be exported in WMF format.



Part V
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6 Manual Example

6.1 General

The data input and results for the Greta manual example are available in the 'Samples' sub-folder
of the program installation folder. The example has been created to show the data input for all
aspects of the program and does not seek to provide any indication of engineering advice. 

Screen captures from this example have also been used throughout this document.

This example can be used by new users to practice data entry and get used to the details of the
program.



Part VII
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7 Brief Technical Description

7.1 Greta

Greta is used for analyzing gravity retaining walls. It performs two calculations which assess the
overall stability of the wall and the forces in the stem and base.

The " Overall stability" option is used for examining the static equilibrium of the wall. The program
assumes that full active and passive soil pressures develop on the virtual boundaries behind and in
front of the wall respectively. The wall is assumed to act as a rigid body together with any soil
encompassed by the vertical planes through the extremities of the base.

The total horizontal and vertical forces are resolved to calculate the force on the base of the wall.
The required reaction of the foundation soil is then calculated to provide equilibrium of the wall.
The bearing capacity of the foundation soil is not checked by the program and must be carried out
as a separate calculation by the user.

The location of the resultant force is also checked and reported. If the rotation of the wall due to
the applied force is towards the heel, then the calculation is stopped.
The program also calculates the horizontal component of load on the wall and the sliding
resistance of the foundation. The user can specify separate shear strength parameters for the
foundation soil to those used for creation of the active and passive pressures.

Application of factors to loads or soil strengths, to assess the factor of safety of the wall, is at the
discretion of the user.

The "Bending moment calculations" option provides shear forces and bending moments in the
stem and base of the wall. This calculation also uses the full active and passive pressures on
either side of the wall. These are applied against the stem and base of the wall and not at the
virtual boundaries. These may be used in the structural design of the wall.
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